PaccmoTpum pelleHune crneaytoLlen 3agaym ¢ UCnosib3oBaHnemM 6anoyHbIX

3N1IeMEHTOB:
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1. Co3gagum HOBbIN Part co cneayoLmnuMm

HaCTpoOMKaMu:

Name:  beam

Modeling Space

© Deformable
() Discrete rigid
©) Analytical rigid

Base Feature

Approximate size: 10

(03D @ 2D Planar ) Axisymmetric

Type Options

None available

[ Continue... ] [ Cancel

HaHo:

K 6anke npsiMoyronbHoOro cevyeHns 0.3x0.5 Ha NOANPYKMHEHHbIX ONopax NPUoXeHa
Harpyska,
3agjaHHasa No 3aKOHYy TpeyrosfibHUKa.



1.1 B pexxnme sketch’a ¢ ncnonb3oBaHMeM MHCTPYMeHTA Create Lines: Connected co3gagum NIMHUIO OSIMHOWM 5 (KYpCOpP HY>XHO YCTAaHOBUTb B TOYKY C
KoopauHaTtamu
x:0, y:0):

- X Pick an end point for the line--or enter X,Y:




‘4" lX Sketch the section for the wire







1.2 Pa3BepHeM BEeTBb Part 1 caenaem ABOMHOM LLIENYOK MbILLW MO NYHKTY Section Assignments, Aanee Bbibepem B OKHE CO3AaHHYH0 NUHUIO U NEPENMEHYEM

set Ha
“beam”:

4§ Models (1)
= Model-1
=] & Parts (1)
& beam
® & Features (1)
b Sets
& Surfaces

® Skins 1

| oo

ﬁ‘ Section Assignments
g

#a Unentations

BEs Composite Layups
3 Engineering Features
B Mesh (Empty)
lw@ Materials
ﬂ Calibrations
ﬂ} Sections
@' Profiles
® ﬁ Assembly
[ ol Steps (1)
B= Field Output Requests
?}3 History Output Requests
b Time Points
B ALE Adaptive Mesh Constraints
T Interactions
& Interaction Properties
;{ Contact Controls
;17’ Contact Initializations
a\{/f Contact Stabilizations
ﬂ] Constraints
E Connector Sections

= Select the regions to be assigned a section I( Create set: | beam I )II

m

[anee

@ F Fields
Alngmplitudes Region Name: |BeamSection
Loads
b Region: beam Category  Type

[l Predefined Fields
Remeshing Rules
[}X Optimization Tasks

Section 5 © Solid | Bearm :

Y Sketches : [ ) Shell russ
“A Annotations Section: EII "/ ' -
Bis Analysis =} 5 6
B Jobs L4 Note: List contains only sections

Adaptivity P i i
E C::X::ttl)trio:zcesses < [€= Select the regions to be assigned a section ( Create set: ) apphcable to the selected SETRORE:
Type:

Material:

Ganc

() Other

[ Continue.. ] | [ Cancel ]




[anee

| & — - -
2% Edit Beam Section [ ® |

Name: BeamSection

Type: Beam

Section integration: @ During analysis (©) Before analysis

Beam Shape

Profile name: L - _E} m 9

Profile shape:

Basic | Stiffness | Fluid Inertia |
Material name:’ E” i

Section Poisson's ratio: 10

Temperature variation:

@ Linear by gradients

(@ Interpolated from temperature points

>
4 Create Profile I R

Name: i RecProfile ‘

Shape

Box
Pipe

I Rectangular

Hexagonal
Trapezoidal
I
L

T

Arbitrary
Generalized

_—
12 [ Continue... l[ Cancel

11

10

& Edit Profile

Name: RecProfile

Shape: Rectangular

T /-
L

ke
|

o]

Cancel

s

13



‘ [anee 3agaem cBonctea MaTepuana 6ankv n HaHavyaem

ce4vyeHune:
& A 3 3 TR - - ‘ 8 l
5+ Edit Beam Section
Name: BeamSection T
Name: | Steel

Type: Beam |

Section integration: @ During analysis ) Before analysis Description:
Beam Shape
Profile name: !RecProﬁIe E]J & Material Behaviors

|

Profile shape: Rectangular

Basic | Stiffness | Fluid Inertia |

Material name:’ H‘ IEI 15

Section Poisson's ratio: l;O ‘

Region: beam

Temperature variation:

@ Linear by gradients General Mechanical Thermal Electrical/Magnetic  Other ‘

Section

() Interpolated from temperature points

Elastic

Type: [ Isotropic EI‘

[T] Use temperature-dependent data

Section: BeamSection <] i‘»"

Note: List contains only sections
applicable to the selected regions.

—Ofﬂ[ Type: Beam

Number of field variables: ’

Material: Steel

=

Moduli time scale (for viscoelasticity): ’ Long-term

No compression
No tension
Data

Young's Poisson's
Modulus Ratio

1




1.3 [lanee Ha3Ha4aeMm OopueHTauuio

Select the regions to be assigned a beam section orientation ( [V] Create set: M ) }975 SIMUL




Eligible Sets

Sets below may contain elements, cells, shell faces,
or wire edges.

Name filter: | :Q"

Name Type

["] Highlight selections in viewport

Continue...

ater an approximate nl direction (tangent vectors are shown) TSN 25 simuLia



$

[lanee Haxumaem KHOMKY Enter n BUAUM Takoe

Click OK to confirm inpui ‘775 sSiuLIA



Eligible Sets

Sets below may contain elements, cells, shell faces, .

or wire edges. RS Select the regions to be assigned a beam section orientation ( Create set: m 1 )
Name filter: [ o

(X

' Name
beam

[anee BbIbupaem Part Display Options (MEHt0
View>
Display Options):

General | Datum | Mesh
Render Style
() Wireframe () Hidden @ Shaded

["] Highlight selections in viewport

Dismiss

Geometry

[] Show dotted lines in hidden render style
Show edges in shaded render style
Show silhouette edges
[T] Highlight only visible entities

Face highlighting: | Stippling H

Curve refinement: | Coarse 7 E]

Note: The refinement setting will be applied only
to the current part.

[] Show reference representation

Mesh
Show: | Exterior edges B

Show edges in shaded render style
[] Highlight only visible entities
Always show substructure with translucency

Idealizations

nder beam profiles

Scale factor: 1 7

[7] Render shell thickness
m Apply Defaults Cancel

1 ‘




- 2
= Select the regions to be assigned a beam section orientation ( || Create set: | Set-2 ) QS SIMULIE




\ 4

Ybupaem otobpaxeHune
CcevYeHus:

I N
¢ Part Display Options u

General | Datum | Mesh

Render Style s
) Wireframe ) Hidden @ Shaded

Geometry
"] Show dotted lines in hidden render style @B by,
Show edges in shaded render style o 4
Show silhouette edges Lol ST
[T] Highlight only visible entities

Face highlighting: | Stippling [+]

Curve refinement: Coarse E

Note: The refinement setting will be applied only
to the current part.

[T] Show reference representation

Apply translucenc

Mesh

Show: %Exterior edges H

= o 4— X| Select the regions to be assigned a beam section orientation ( Create set: ‘Seitiz ) Sets... X
Show edges in shaded render style = PS SIMULIE

[T] Highlight only visible entities
Always show substructure with translucency

lizations
[] REnder beam profiles

Scale factor: [

[ Render shell thickness

oK I! Apply II[ Defaults | | Cancel |




1.4 [lanee co3gaem npyxuHbl, pa3BepHyB BETBb Engineering Features 1 LLENKHYB ABa pasa no nyHKTY
Springs/Dashpots:

=48 Models (1)
- B Model-1
| El S Parts (1)
 © beam
& Features (1)
i Sets (1)
By Surfaces
-~ @ Skins
i 0 Stringers
$& Section Assignments (1)
B Orientations
- B8 Composite Layups
=43 Engineering Features
: - i Inertias
e
| - Ba Mesh (Empty)
[Pz Materials (1)

- - .
— Cyreate Springs/Dashpots M 5+ Create Spring;/Dashpots M
Name: Srins/Dashots-l ‘ Name: 'Sprind J

Connectivity Type Connectivity Type
| Connecttwopoints | | Connect two points
Connect points to ground (Standard) l Connect points to ground (Standard)

\ -_— " o




¥

[anee BbiOMpaem B OKHe [Ba KpaHMX KoHLUa b6anku n Haxkumaem Done (yoep»KuBasi KnaBuLLy

Select points to connect to ground with springs/dashpots- ,975 sSiMuLIA




\

[lanee 3apaem cteneHy cBo6Oabl U KECTKOCTb

- MNDV>KUHbI:
& Edit Springs/Dashpots

<

X4

Name: Spring

Type:  Connect points to ground (Standard)
Region: (Picked)
Direction

Degree of freedom{ 2 B 1

Orientation: (Global) [} o4

Property
[¥] Spring stiffness: 50e6 2

("] Dashpot coefficient:

Coc |3 (o)

A = ,

$




2 Cosgaem ceTky Ans Hawewn
Oanku:
& Model Database El

= 4§ Models (1)
= Model-1
=W Parts (1)
= beam

& Features (1)

o Sets (1)
& Surfaces
® Skins
ﬂ Stringers

@ 3 Section Assignments (1)

~Bw Orientations
B, Composite Layups

=483 Engineering Features

i Inertias

Elg Springs/Dashpots (1)

Sprin
[ TR 1 (1.
i [72 Matenars (1) WenavuoK)

>

- .
45 Global Seeds

N

e P
R=HE

N

Fy
5, &

Sizing Controls

Approximate global size] 3 q 3

Curvature control
Maximum deviation factor (0.0 < h/L < 1.0): |0.1
(Approximate number of elements per circle: 8)

Minimum size control

@ By fraction of global size (0.0 < min <1.0) |01

() By absolute value (0.0 < min < global size)  0.026

5

4

| Apply |

| Defaults |

[ Cancel

L ok




¥

[anee pasbueaem ceTky Ha KO (Haxxumaem KHomnkKy Mesh

4= [X]| oK to mesh the part No] 25 simmuL
2




\

\

[anee BbIbupaem Tnn anemeHTa (MeHto Mesh>Element

Type):

4 AbogqusUAL 614-! [Viewsort 1]
=) Ele Mcde! Viewpos Visw Seed
. = = 4 &
LEEmER + ¢«
Yodel Rl
25 Mod:I Catsbae
B 3 Madels U
13 Muie-!
Hils pats (1)
l= beam
E & Feslue (1)
= dr Sex (1)
L
® Skrs
1 Suingers

= 22 Se tim Al (1)

Mesh  fAdaptivisy  “eaure  Took

Conios

Unentstion

Glibed Mnbesing Condra...

Pl

Begon..

>

Dclcte 't Netree Mesh.,

Delete Regicn Native Mach...
Creata Zottzm-Up Mesh...
Al Wesls sith Sretiy
Deicte Mesh Assonxraty.

Ede..

Creats Miesr Part. .

Vet

BbiGrpaem B okHe Hally 6anky 1 Haxknmaem

Done:
(1111 ’L‘
RS
5
o
*

- Select the regions to be assigned element types

-m j)’S simMmuLl



Element Library Family

@ Standard ) Explicit  Acoustic

I, -

Geometric Order i Coupled Temperature-Displacement

@ Linear ) Quadratic i Gasket

| Line

Hybrid formulation

Element Controls

Beam type: @ Shear-flexible () Cubic formulation

Scaling factors: Linear bulk viscosity: \174’

B21: A 2-node linear beam in a plane.

Note: To select an element shape for meshing,
select "Mesh->Controls” from the main menu bar.




3. Co3gaem Instance, pa3BopadnBasi BETBb

Assembly>Instances:
& Model Database EI >

%8 Models (1)
= Model-1
=l Parts (1)
= beam
# & Features (1)
# fy Sets (1)
My Surfaces
® Skins
a Stringers
&+ ﬁ; Section Assignments (1)
s Orientations
B2, Composite Layups
=2 Engineering Features
i Inertias
Eig Springs/Dashpots (1)
Spring
Bn Mesh
@ 72 Materials (1)
&} Calibrations
# §E~ Sections (1)
-+
E14d Assembly

s | 1-/B.

- “ﬂ Position Constraints (
47 Create Instance %

Create instances from:

|

Instance Type

A meshed part has been selected, so
the instance type will be Dependent.

Note: To change a Dependent instance's
mesh, you must edit its part's mesh.

[7] Auto-offset from other instances

LY B ) ()
= ——

2

https://www.youtube.com/watch?v=ufBd_S2LZpE




4. Co3gaem Step, ABa pasa LLENKHYB Mo BETBU
Steps:

= ﬁ MIQIodels (15
. E Model-1
S Parts (1)
E] Beam Name: ] load Name: load

: Type: Static, General
& Features (1) Insert new step after .
> Basic I Incrementation I Other I

@ g Sets (1) f s T :
o Skins Time period: \j

ﬂ Stringers

Nigeom: © off (This setting controls the inclusion of nonlinear effects

3; Sechion A ts (1) @ on of large displacements and affects subsequent steps.)

t 3L Section Assignments - .
[ Orientations Automatic stabilization: | None E]
B8 Composite Layups

= 43 Engineering Features Procedure type: | General [T Include adiabatic heating effects
iy Inertias o S ——

] namic, Temp-disp, ici
E]g Springs/Dashpots (1) o ¢ BIERER
/ Geostatic

: S Heat transfer

- Bn Mesh

[P Materials (1)
E E‘r Calibrations
S Sections (1)
& Profiles (1)
£ Assembly

Elolu-l I Continue... I [ Cancel ]

o Initial

Soils

| Static, General
Static, Riks
< | I | »

Mass diffusion |




5. [lJanee HaM Hy>XHO co34aTb aHaNNTUYECKY0 3aBMCUMOCTb, KOTOPYHO BNOCNEACTBMM Mbl Byaem ncnonb3oBaTh AN 3agaHus Harpy3ku. PassopaymBaem
BETBb Fields
W ABaXabl Wenkaem no pasneny Analytical Fields:

Name: FIineLoad

Description: |

Enter an expression by typing and selecting parameter names and operators below.
Note: Parameter names and operators are case sensitive.

Example: 2.5"X + pow(Y,3)

Name: | lineLoad

= F Fields
- & Discrete Fields » Type
(£1] Analytical Fields @ Expression field

() Mapped field

-120e3*X+600e3

Local system: {Global) [3 » Operators

Local system type: Rectangular A,B - parameters
Parameter Names '

| X
X

| Continue...l” Cancel ] |

Cancel




6. CosgaeM Harpysky, ABaX bl LLENKHYB N0 BETBU
Loads: [anee Mbl OMKHbI BbIOpaTh 6anky u set, HaxaB Ha KHOMKY

Name: | TriangleLoad

Step: | load E]

Procedure: Static, General

. Category Types for Selected Step
= Fields
f 2 : @ Mechanical Concentrated force
M Discrete Fields s Moment
fix) Analytical Fields (1) | © Acoustic S
: . Shell edge load
m Amplltudes i ) ) Surface traction
B Loads 9 Flléd"féllvéénet'( Pipe pressure

ass 0 Body force
Gravity
Bolt load

Select bodies for the load ( [7] Create set: [Set1  |) - 2 simuLia

Name: TriangleLoad
Type: Lineload

Eligible Sets
Step: load (Static, General)

Sets below may contain elements, cells, shell faces,
or wire edges. Region: beam-1.beam

Name filter: 2% System: Global
Name

beam-1.beam

Distribution: | lineLoad

Component1: |0

Component 2: ]I

[7] Highlight selections in viewport Amplitide i (Ramp)




Ha akpaHe 4omKHO NosiBUTLCSA NpeAcTaBreHne Harpy3ku B BUae

6.1 MomeHsieM HanpaBneHne Harpy3Kku, OTpeaakTMPOBaB MYHKT TriangleLoad, 3aMEHUB KOMMOHEHTY Y C 1
Ha -1: T [

: TriangleLoad
Line load
load (Static, General)
ion: beam-l.beam [

= [ Loads (1) System: Global H
@ Trianglel-oad Distribution: | lineLoad B fix)
Component1: 0

Component 2: | -1

Amplitude: (Ramp) E| r\l




Hpyron cnocob caenatb TO e caMmoe — 3TO co3aaTb KOOpAUHATHY cuctemy CSYS. NogaBum BpeMeHHO NyHKT TriangleLoad 1 3angemM B MEHHO

Tools>Datum>CSYS:
Tooss Pug-nt  Hel

Doy
Type

Jersrence Pork .. E 2 = 2
= ) Point ) Axis () Plane @ CSYS
et
Wlme » Method Name: | Datum csys-2
Dantition.. [3points Coordinate System Type
- | _

| 2 lines _
2 ibude > [ © Cylindrical
6--";'_"“(3‘ F od > (_) Spherical
ENRE 1Y E__-r{d »
Seplyy Greup > [ Continue... ] [ Cancel ]
diew Cut -
ustoree..
Jztions.

Select a point to be in the X-Y plane--or enter XY,Z w[ I Create Datuml /775 SIMULIA




Name: TR

Coordinate System Type
@ Rectangular

() Cylindrical

() Spherical

[ Continue... ]|| Cancel




CHoBa co3gaem Harpysky, ABaxabl LLENKHYB Mo BETBU

Loads & nweracuuns 7 Eligible S
| ‘& Interaction Properties & Create Load 'gible >ets
11 ﬁ Contact Control Sets below may contain elements, cells, shell faces,
Iy, Name: ‘triangleZ or wire edges.
’ gfﬂ' Contact Initializations
4 Contact Stabilizations Step: ‘load E” Name ﬁ|t€f=‘_ ‘ G
% oA Procedure: Static, General Name Type |
: Connector Sections \
5 F Fields Category Types for Selected Step | beam-1.beam Geometry
i M Discrete Fields © Mechanical ' Concentrated force - ‘
f(x) Analytical Fields (1) Thermal Moment
Pv Amplitudes Acoustic Pressure . vt
, e = Highlight selections in viewport
Shell edge load 2
=] oads 1) i : :f e gt;ect:'a
TriangleLoad ) . i AacEFmcEon m
[ BCs ) Electrical/Magnetic Pipe pressure _
- [ Predefined Fields Mass diffusion | Body force
'- Remeshing Rules () Other
- Optimization Tasks Gravity
‘ I& Sketches Bolt load -
@ Annotations .
548 Analsis [Continee-
ok N N Name: triangle2

Type:  Linelcad
Step: load (Static, General)

Region: beam-1.beam Name: ‘ lineLoadd

Type
@ Expression field

System: ‘ Global

Distribution: jUniform ) Mapped field

Component 1: ‘

l Continue... ][ Cancel

Component 2: i

Amplitude: ‘ (Ramp)




[lanee Hy>HO BbIOpaTb KOOPAMHATHYI CUCTEMY csys-2 U MPONMcaTb aHaNUTUYECKYHO

3aBNCMMOCTb:

¢ Create Expression Field

Name: |[ R

Description: ’;

Enter an expression by typing and selecting parameter names and operators below.

Note: Parameter names and operators are case sensitive.

Example: 2.5°X + pow(Y,3)

Local system: (Global} IQ 14
Local system type: Rectangular
Parameter Names

X
y

Cancel |

Operators

AB - parameters

0 ||

[/
| %
pi
5 v

Name: | lineLoad2

Description:

Enter an expression by typing and selecting parameter names and operators below.

Note: Parameter names and operators are case sensitive.

Example: 2.5*X + pow(Y,3)

|1zoa*x

Local system: Datum csys-2 [y L
Local system type: Rectangular

Parameter Names

X
Y

Operators

A,B - parameters
0

+

*

/




Name: triangle2

Type:  Lineload

Step:  load (Static, General)
Region: beam-1.beam
System: Global
Distribution: | lineLoad2
Component1: 0
Component 2: | -1

Amplitude: (Ramp) EJ r\l




7. HactpanBaem Heobxogumble napameTpbl

BbIBOAA:

LI T§ LHYnISSiny | catuies

i Inertias
a{{. Springs/Dashpots (1)
spring
Bn Mesh
[Pz Materials (1)
E} Calibrations
2 Sections (1)
& Profiles (1)
#3 Assembly
ol Steps (2)
[ o= Initial
o8 |oad
= B2 Field Output Requests (1)
i
c3] EH History Output Requests (1)
|'*_*; Time Points
Bp ALE Adaptive Mesh Constraints
‘T Interactions
& Interaction Properties
t{ Contact Controls
4‘2’ Contact Initializations
% Contact Stabilizations
'ﬂ] Constraints
@ Connector Sections
= F Fields
& Discrete Fields
f(x) Analytical Fields (2)
Pv Amplitudes
B [ Loads (2)
X TriangleLoad
triangle2
L BCs
[Ls Predefined Fields
Remeshing Rules
I ¢ Optimization Tasks
Y Sketches
N Annotations
= i; Analysis
=& Jobs (1)

45 Edit Field

Name: F-Output-1

Step: load

Procedure: Static, General

Domain: | \Whole model E] [T] Exterior only

Frequency: | Every n increments E] n: 1
Timing: ;Joutputatexacttimes ‘7

Output Variables
@ Select from list below () Preselected defaults ) All () Edit variables

S,PE,PEEQ,PEMAG, LE,U,RF,CF,NFORCSO, CSTRESS, CDISP
¥ UISpPIGLEIICiy ¥ EIULILy ALCEISiGUUTT
v Forces/Reactions
RF, Reaction forces and moments
[] RT, Reaction forces
[7] RM, Reaction moments
CF, Concentrated forces and moments
[] SF, Section forces and moments
[ TF, Total forces and moments
[T VF, Viscous forces and moments due to static stabilization
["] ESF1, Effective axial force for beams and pipes subjected to pressure loz
|| NFORC, Nodal forces due to element stresses
NFORCSO, Nodal forces
[ RBFOR, Force in rebar
[T] BF, Body forces
[7] CORIOMAG, Magnitude of Coriolis loads

m

ol mATasear~ sa = 53§ s SRS

< m | »

Note: Some error indicators are not available when Domain is Whole Model or Interactic

[T] Output for rebar

Output at shell, beam, and layered section points:
@ Use defaults ) Specify:

Include local coordinate directions when available

=]




8. Co3naeM 3agady, ABaXKabl LLIETNTKHYB Mo BETBU

Jobs:

= [ Loads (2)
X TriangleLoad
_ triangle2
-5 BCs
- [l Predefined Fields
- Remeshing Rules
-} Optimization Tasks
v I Sketches
A Annotations
E]ii Analysis
‘=
%ﬂ Adaptivity Processes
B Co-executions
& 4 Optimization Processes

.
4 Create Job

Name: JirJob-l

Source: | Model E”

Model-1

II Continue...

Cancel

Name: Job-1
Model: Model-1

Analysis product: Abaqus/Standard

Description: !I

Submission

General | Memory I Parallelization | Precision

Job Type
@ Full analysis

Recover (Explicit)

Run Mode

@ Background ) Queue:

Submit Time

@ Immediately

Wait: Dhrs.’jmin.

Switch Context Ctrl+Space
Edit...

Copy...

Rename...

Delete... Del
Write Input

Moenitor...

Results

B



9. lNocne 3aBepLueHNa peLleHuns (ctatyc peweHna Completed), nepexoanm B Mogysnb NOCTNpoOLEcCcuHra
(Results):

DEE®mE &b e CKEM ?qi primary [+ U o2 K 8 & (K] e @O G IDOT G @ @@ o K ) Ryl 5| visuwlstion defouts [7] @
- Model | Results Module: |4 Visualization : Model: [ C:/Users/dk497d/Job-1.0db E| a4 D> BEBD

= triema 2 ~ - Session Data HsE % ¢ E
B St Context Sl Space 7] Ouput Dtabsses (1)
e K< — @& Model Database (1) ‘
‘-' @ [1 Spectrums () B B -
Ll__‘ Pragzfi~ £ gxwlm [Q“
XVData
o Fromms ‘:0;'( - [, Paths TR
'a wms @ 4 Display Groups (1) s
. Henmms B Free Body Cuts
Jt Op e Streams
) 3 [T Movies
1% Skewche Delete. . Del e
I An-oteticns Wrte Input
A T ~
t-.‘:? Aned Dula Chuee
G, Joc« Subeit

R AdpTvty | i

— The job :

2l Job Job-2
. Jab Job.2

»;I | J a0 Job-1 Econ >




10. YBENNYMM YMCIIO SNIEMEHTOB U 3aHOBO 3arMyCTMB PeLleHne, MOCMOTPUM Ha OTKITUK
KOHCTPYKLUUN:

Sizing Controls
Approximate global size: | 0.5
Curvature control

Maximum deviation factor (0.0 < h/L <1.0): 0.1
(Approximate number of elements per circle: 8)

Minimum size control

@ By fraction of global size (0.0 < min <1.0) |0.1

() By absolute value (0.0 < min < global size) 0.6

ok | | Apply | | Defaults | | Cancel

Some part or instance meshes will be invalidated by the seeding changes.

_ You may either delete the affected meshes or cancel the
/1 part seeding operation.

F Automatically delete meshes invalidated by seed changes.
(Do not repeat this warning dialeqg.)

Sizing Controls
Approximate global size: |0.5
Curvature control

Maximum deviation factor (0.0 < h/L <1.0): |0.1
(Approximate number of elements per circle: 8)

Minimum size control

@ By fraction of global size (0.0 < min <1.0) |01

(0) By absolute value (0.0 < min < global size) 0.6

oK [ Apply ] [Defaults] [ Cancel ]




$

Switch Context Ctrl+Space

Edit...
Copy...
Rename...
Delete...

Del

Write Input
Data Check

Subﬁt
Contiue

Monitor...
Results
Kill

Buanm geopmmnpoBaHHyro

opmy:

4-?“ Primary E] S

11040

Module: [ Visualization : Model:|;C:,/Users/dk497d/Job—1.odb H

b V|

o
giii& E%EG
5%

H Mises

il
+9.

S
200e

I E AR

+06

H® | @ & 3T T

1729 ; JHC 1)

# Visualization defaults IE




BbiBoaum

aedopmaunu:

[primary  [¢]u v  HS: 8 &R H® & O & T @ Q@@ ® K R T | visuatization
Module: |2 Visualization : Model:|;C:/Users/dk497d./Job-1.odb E[

b
-




[anee MoXHO nocMmoTpeTb Axial forces /OceBble cunbl/ B
banke:

primary [ NForsor -] IS g & K] B s ale A @@ ® K &2 B |Visvalzation
Module: I Visualization : Model: |- C:/Users/dk497d/Job-1.cdb ]
ﬂ bl g

gg:: NFORCSO1

R O3 (Avg: 75%)

+1.746e-10
+1.552e-10
+1.358e-10
+1.164e-10
+9.701e-11
+7.761e-11
+5.821e-11
+3.8681e-11
+1.940e-11
+3.469e-18
-1.940e-11
-3.881e-11
-5.821e-11




Shear forces /[epepesbiBatoLLne cusol/ B
banke:

Primary || NFORCSO2 []

ﬂ

E]@ g A §A||

Module: | Visualization : Model: |- C:/Users/dk497d/Job-1.0db
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